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Планируемые результаты обучения по дисциплине  

«Спецглавы теории управления мехатронными системами»  

 

Целью дисциплины является формирование профессиональных 

Целью дисциплины является формирование профессиональных зна-

ний и навыков в области теории нечетких множеств, нечеткой логи-

ки, искусственных нейро-нечетких сетей и нечеткого управления, 

необходимых для дальнейшей деятельности в качестве исследовате-

ля, инженера-конструктора, инженера-робототехника и в других ви-

дах научно-исследовательской и инженерной деятельности. 

Задачи дисциплины: 

 изучение теории нечетких множеств; 

 изучение операций над нечеткими множествами; 

 изучение и исследование искуственных нейро-нечетких сетей; 

 изучение и исследование нечеткого логического вывода на основе 

алгоритмов Мамдани, Ларсена, Цукамото, Сугено;  

 изучение особенностей практического применения алгоритмов 

нечеткого логического вывода (в системах нечеткого управления, в 

том числе интеллектуального); 

 изучение основ проектирования и кодирования программного 

обеспечения систем нечеткого управления, в том числе интеллекту-

ального. 

Процесс изучения дисциплины «Спецглавы теории управления 

мехатронными системами» направлен на формирование следующих 

компетенций: 

ПК-1 способностью составлять математические модели мехатрон-

ных и робототехнических систем, их подсистем и отдельных 

элементов и модулей, включая информационные, электроме-

ханические, гидравлические, электрогидравлические, элек-

тронные устройства и средства вычислительной техники 

ПК-11 способностью производить расчеты и проектирование от-

дельных устройств и подсистем мехатронных и робототехни-

ческих систем с использованием стандартных исполнитель-

ных и управляющих устройств, средств автоматики, измери-

тельной и вычислительной техники в соответствии с техниче-

ским заданием 
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Лабораторная работа№1 

Разработка системы нечеткого логического вывода,  

реализующей подход Мамдани 

 

Цель работы 

 

Исследование алгоритма нечеткого вывода Мамдани, качест-

венная оценка результатов аппроксимации строго детерминирован-

ной зависимости между аргументами и значением функции нечетким 

логическим выводом по набору лингвистических правил. 

  

Теоретическая часть 

 

В алгоритме Мамдани используется минимаксная композиция 

нечетких множеств. Алгоритм включает в себя следующую последо-

вательность этапов: 

1. фаззификацию (приведение к нечеткости); 

2. нечеткий вывод; 

3. дефаззификацию (приведение к четкости). 

Сущность процедуры фаззификации заключается в определении 

степени истинности антецедентов, т.е. значения функций принад-

лежности для антецедентов каждого правила. Для базы с m  правила-

ми и n  посылками в антецеденте степень истинности обозначается 

как n.1,...,k m,,...,1),( ixkik  

Формирование логического решения осуществляется следую-

щим образом.  

Изначально определяются уровни «отсечения» для антецедента 

каждого из правил: 

 ))((min kik
i

i xalfa   (1) 

Далее находятся «усеченные» функции принадлежности консе-

квента: 

 ))(,(min)(' yalfay ii
i

i    (2)

  

Затем осуществляется композиция полученных усеченных 

функций, для чего используется максимальная композиция нечетких 

множеств: 
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 ))((max)( ' yy i
i

  , (3) 

где )(y  – функция принадлежности итогового нечеткого множества.  

Последним этапом является дефаззификация, которая заключа-

ется в приведении к четкости результата композиции множеств на 

предыдущем этапе. В алгоритме Мамдани применяется метод центра 

тяжести, или центроидный метод: 

 

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На рис. 1.1 представлена графическая интерпретация процесса 

нечеткого вывода по Мамдани для двух входных переменных '

1X  и '

2X  

и двух нечетких правил R1 и R2. 
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Рисунок 1.1– Графическая интерпретация процесса нечеткого вывода 

по Мамдани 

Также существуют другие алгоритмы нечеткого вывода (Суге-

но, Ларсена, Цукамото). От алгоритма Мамдани они отличаются: 

1. видом используемых правил; 

2. типом логических операций; 

3. методом дефаззификации. 
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Практическая часть 

 

Проектируемая система должна моделировать зависимость 

)1sin( 2

2

1  xxy  в области ]3,7[1 x , ]7.1,4.4[2 x . Проектирование системы 

необходимо осуществить на основе трехмерного изображения ука-

занной зависимости (рис. 1.2), которое построено следующей про-

граммой: 

n=15; 

x1=linspace(-7,3,n); x2=linspace(-4.4,1.7,n); 

y=zeros(n,n); 

for j=1:n 

y(j,:)=x1.^2*sin(x2(j)-1); 

end 

surf(x1,x2,y); 

xlabel('x_1'); ylabel('x_2'); zlabel('y');  

 

 
Рисунок 1.2 – График функции )1sin( 2

2

1  xxy  

 

Поверхности на рис. 2 ставится в соответствие следующие семь 

нечетких правил: 

1. ЕСЛИ 1x = «Низкий» И 2x  = «Низкий», ТО y  = «Высокий»; 

2. ЕСЛИ 1x = «Низкий» И 2x  = «Средний», ТО y  = «Низкий»; 

3. ЕСЛИ 1x = «Низкий» И 2x  = «Высокий», ТО y  = «Высокий»; 

4. ЕСЛИ 1x = «Средний», ТО y  = «Средний»; 

5. ЕСЛИ 1x = «Высокий» И 2x  = «Низкий», ТО y  = «Выше сред-

него»; 
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6. ЕСЛИ 1x = «Высокий» И 2x  = «Средний», ТО y  = «Ниже сред-

него»; 

7. ЕСЛИ 1x = «Высокий» И 
2x  = «Высокий», ТО y  = «Выше 

среднего». 

Проектирование нечеткой системы состоит в выполнении сле-

дующей последовательности шагов. 

1. Открыть FIS-редактор, напечатав слово fuzzy в командной 

строке. После этого появится новое окно, показанное на рис. 1.3. 

2. Добавить вторую входную переменную (Edit->Add Variable-

>Input).  

 

 
Рисунок 1.3 – Окно FIS-редактора 

 

3. Переименовать входные и выходную лингвистические пере-

менные в поле Name FIS-редактора. 

4. Сохранить проект (File->Export->To Disk). 

5. Перейти в редактор функций принадлежности двойным 

щелчком левой кнопки мыши на блоке 1x . 

6. Задать диапазон изменения переменной 1x , напечатав -7 3 в 

поле Range и нажав Enter. 

7. Задать функции принадлежности термов лингвистической 

переменной 1x . Для лингвистической оценки этой переменной пред-

лагается использовать три терма с треугольными функциями принад-

лежности. Задать наименования термов переменной («Низкий», 
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«Средний», «Высокий»), выделив их функции принадлежности и от-

редактировав поле Name (рис. 1.4.). 

 

 
Рисунок 1.4 – Окно редактора функций принадлежности 

 

8. Перейти в редакторе функций принадлежности к переменной 

2x . Проделать шаги 6-7 для переменной 2x . Единственным отличием 

здесь будет диапазон. 

9. Перейти в редакторе функций принадлежности к блоку y . 

Для лингвистической оценки этой переменной предлагается исполь-

зовать пять термов с гауссовыми функциями принадлежности. 

10. Задать диапазон изменения переменной y , напечатав -50 

50 в поле Range и нажав Enter. 

11. Удалить функции принадлежности, установленные по 

умолчанию, выполнив Edit->Remove All MFs.  

12. Добавить гауссовы функции принадлежности, выполнив 

Edit->Add MFs и выбрав в появившемся диалоговом окне MF type = 

gaussmf, Number of MF’s = 5. Задать следующие наименования тер-

мов переменной y : «Низкий», «Ниже среднего», «Средний», «Выше 

среднего», «Высокий».  

13. Перейти в редактор базы знаний, выполнив Edit->Rules. 

14. Для ввода правила необходимо выбрать в меню соответст-

вующую комбинацию термов и нажать Add rule. Окно редактора 
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правил представлено на рис. 1.5. В конце каждого правила в скобках 

указан весовой коэффициент. 

 

 
Рисунок 1.5 – Окно редактора правил 

 

15. Сохранить проект (File->Export->To Disk). 

16. Выполнить View->Rules. Появиться окно визуализации не-

четкого вывода (рис. 6). 

 

 
Рисунок 1.6 – Окно визуализации нечеткого вывода Мамдани 
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17. Выполнить View->Surface. Появится окно с изображением 

поверхности «входы – выход», соответствующей синтезированной 

нечеткой системе (рис. 1.7). 

 
Рисунок 1.7 – Окно просмотра поверхности 

 

 

 

 

 

 

Задание на лабораторную работу 

 

1. Изучить материал теоретической части. 

2. Синтезировать систему нечеткого логического вывода для 

функции, предложенной в практической части. 

3. Построить трехмерное изображение функции, использую 

программный код, представленный в первом пункте практической 

части. 

4. Сравнить полученную поверхность с поверхностью «входы – 

выход», которая соответствует синтезированной нечеткой системе. 

Сделать вывод. 

 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 
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1. скриншоты типа рис. 1.2, 1.4, 1.6, 1.7 с пояснениями; 

2. качественную оценку сравнения поверхностей, полученных 

разными способами; 

3. выводы, наличие которых определено заданием. 
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Лабораторная работа№2 

Идентификация объекта управления на базе синтеза нечеткой 

нейронной сети типа ANFIS 

 

Цель работы 

 

Изучение структурно-функциональной организации много-

слойной сети прямого распространения (многослойного персептрона) 

и градиентного метода обучения, исследование влияния параметров 

обучения и структуры нейронной сети на качество идентификации. 

 

Теоретическая часть 

 

Искусственные нейронные сети (ИНС) – сети с конечным чис-

лом слоев из однотипных элементов – искусственных (формальных) 

нейронов с различными типами связей между слоями. При этом ко-

личество нейронов в слоях выбирается необходимым для обеспече-

ния заданного качества решения задачи, а число слоев нейронов как 

можно меньшим с целью уменьшения времени решения задачи. 

Каждый нейрон характеризуется своим текущим состоянием по 

аналогии с нервными клетками живого организма, которые могут 

быть возбуждены или заторможены. Он обладает группой синапсов – 

однонаправленных входных связей, соединенных с выходами других 

нейронов, а также имеет аксон – выходную связь данного нейрона, с 

которой сигнал (возбуждения или торможения) поступает на синап-

сы следующих нейронов. Структурно-функциональная организация 

формального нейрона представлена на рис. 1. 

Каждый синапс характеризуется величиной синаптической свя-

зи или ее весом wi, который по физическому смыслу эквивалентен 

электрической проводимости. 

Текущее состояние нейрона определяется как взвешенная сум-

ма его входов: 

 



n

i

ii wxS
1

,  (1) 

где n  – число входов нейрона; ix  – значение i го входа нейрона; iw  – 

вес i го синапса. 

Выход нейрона есть функция его состояния 
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 )()( 0 SfwSfY  ,  (2) 

где f  – некоторая функция, называемая активационной; 0w – «нейрон-

ное смещение», вводимое для инициализации сети, – подключается к 

неизменяемому входу «+1» (на рис. 2.1 такой вход не показан). 

 

 
Рисунок 2.1 – Структурно-функциональная организация искусствен-

ного нейрона 

 

Активационная функция может иметь различный вид, как пока-

зано на рис. 2.2. 

 
Рисунок 2.2 – а) ступенчатая функция; б) линейный порог; 

в) гиперболический тангенс; г) сигмоида 

 

Одной из наиболее распространенных является нелинейная 

функция с насыщением, так называемая логистическая функция или 

сигмоида (т.е. функция s-образного вида): 

 
xe

xf



1

1
)( . (3) 

логой, при 

и-
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и-

ничного скачка с порогом T в точке x=0. Из выражения для сигмоиды 

очевидно, что выходное значение нейрона лежит в диапазоне [0,1]. 

Одно из ценных свойств логистической функции – простое выраже-

ние для ее производной: 

 ))(1)(()( xfxfxf   .  (4) 

Следует отметить, что логистическая функция является глад-

кой, что используется в некоторых алгоритмах обучения. Кроме того, 

она обладает свойством усиливать слабые сигналы лучше, чем силь-

ные, и предотвращает насыщение от сильных сигналов, так как они 

соответствуют областям аргументов, где сигмоида имеет пологий на-

клон. 

ИНС может рассматриваться как направленный граф с взве-

шенными дугами, в котором искусственные нейроны являются узла-

ми. По архитектуре связей ИНС могут быть сгруппированы в два 

класса: сети прямого распространения, в которых графы не имеют 

петель, и рекуррентные сети, или сети с обратными связями. 

В наиболее распространенном семействе сетей первого класса, 

называемых многослойными персептронами, нейроны расположены 

слоями, связанными однонаправлено. Синтез сети именно такого ти-

па рассматривается в данной работе. 

Сети прямого распространения являются статическими в том 

смысле, что на заданный вход они вырабатывают одну совокупность 

выходных значений, не зависящих от предыдущего состояния сети. 

Функциональные особенности нейронов и способ их объедине-

ния в сетевую структуру обуславливают ту или иную парадигму 

ИНС. Для решения задач идентификации и управления наиболее 

адекватными, без сомнения, являются многослойные ИНС (МНС) 

прямого действия или многослойные персептроны (МСП). При про-

ектировании МНС нейроны объединяются в слои, каждый их кото-

рых обрабатывает вектор сигналов от предыдущего слоя (или вход-

ной вектор). Минимальной реализацией является двухслойная ИНС, 

состоящая из входного (распределительного), промежуточного 

(скрытого) и выходного слоя. При подсчете числа  слоев входной 

слой обычно не учитывается, так как служит лишь для распределения 

входных сигналов по нейронам последующего слоя. На рис. 2.3 

представлена структурная схема двухслойной ИНС прямого распро-
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странения. Сигналы в сети распространяются от входа к выходу, свя-

зи между нейронами одного слоя и обратные связи отсутствуют. 
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Рисунок 2.3 – Структурная схема двухслойной нейронной сети 

 

Реализация модели двухслойной ИНС прямого распространения 

имеет следующее математическое представление: 

 ))((),(ˆ)(ˆ
1

0

1

0 
 


hn

j

i

n

l

jljljijiii WwwfWFyy


Wwθ ,  (5) 

где n  – размерность вектора входов   нейронной сети; 

hn  – число нейронов в скрытом слое; 

θ  – вектор настраиваемых параметров нейронной сети, вклю-

чающий весовые коэффициенты и нейронные смещения ( ijjl Ww , ); 

)(xf j  – активационная функция нейронов скрытого слоя; 

)(xFi  – активационная функция нейронов выходного слоя. 

Рассмотрим функционирование МНС как совокупности взаимо-

связанных элементарных элементов (нейронов) с математической 

точки зрения. Каждый структурный элемент МНС получает на входе 

вектор сигналов φ, вычисляет его скалярное произведение на вектор 

весовых коэффициентов нейрона W  и некоторую функцию F  в вы-

ходной сигнал y . Результат поступает на входы других нейронов или 

на выход. Таким образом, нейронные сети вычисляют суперпозиции 

функций одного переменного и их линейные комбинации. Для обос-

нования возможности использования МНС в качестве моделей дина-

мических систем нужно получить ответ на вопрос: можно ли произ-

вольную непрерывную функцию n  переменных получить с помощью 
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операций сложения, умножения и суперпозиции функций одного пе-

ременного? 

В серии работ А.Н. Колмогорова и В.И. Арнольда решена сле-

дующая математическая проблема (составляющая существо трина-

дцатой проблемы Гильберта): любую непрерывную функцию n  пе-

ременных можно получить с помощью операций сложения, умноже-

ния и суперпозиции из непрерывных функций одного переменного. 

На основе этих работ доказан ряд теорем об аппроксимации непре-

рывных функций многих переменных ИНС с использованием прак-

тически произвольной функции одного переменного. Помимо под-

тверждения общих аппроксимирующих свойств МНС необходимо 

получить ответы на ряд частных вопросов, касающихся структуры 

сети: 

Сколько скрытых слоев должна содержать нейронная сеть? 

Сколько нейронов должно быть включено в каждый слой? 

Какой тип активационной функции должен быть выбран? 

По мнению некоторых исследователей, любая непрерывная не-

линейная функция может быть аппроксимирована с достаточной 

точностью ИНС с одним скрытым слоем, содержащим нейроны с 

сигмоидальными (или типа «гиперболический тангенс») функциями 

активации, и выходным слоем, содержащим нейроны с линейной ак-

тивационной функцией. Сделаны попытки исследования влияния 

числа нейронов в скрытом слое на аппроксимирующие свойства се-

ти, однако полученный результат практически невозможно приме-

нить на практике. 

В настоящей работе рассматривается минимальная реализация 

МНС в соответствии с выражением (5) и активационными функция-

ми типа «сигмоида» для нейронов в скрытом и выходном слоях. 

Возможно, репрезентативные способности МНС могут быть улучше-

ны путем введения дополнительных скрытых слоев, особенно в слу-

чае моделирования сложных взаимосвязей. Однако усложнение 

структуры МНС приводит к значительным трудностям при практи-

ческой реализации, обучении и последующем анализе. Это объясняет 

факт использования именно минимальной реализации МНС в боль-

шинстве технических приложений. 

Предположим, что в результате проведения эксперимента и 

предварительной обработки данных получено некоторое множество 
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  NttytuN ,1)],(),([ Z ,  (6) 

где )(),( tytu  – соответственно входы и выходы системы, N  – число 

дискретных отсчетов. Допустим также, сто выбрана некоторая мо-

дельная структура 

 )()|(ˆ)( tetyty  θ . (7) 

В соответствии с общей схемой реализации процедуры иденти-

фикации следующим этапом является оценка параметров выбранной 

модельной структуры. При использовании нейросетевых модельных 

структур этот этап представляет собой настройку весовых коэффи-

циентов сети в результате реализации процедуры обучения на мно-

жестве примеров. Обучение представляет собой отображение множе-

ства экспериментальных данных на множество параметров нейросе-

тевой модели 

 θZ ˆN   (8) 

с целью получения оптимального, в силу некоторого критерия, про-

гноза выходного сигнала ŷ . Традиционно используемым критерием 

является среднеквадратичная ошибка прогнозирования 

 
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1

),( θθZθ . (9) 

Данный подход относится к классу методов ошибки прогнози-

рования (МОП), так как основной задачей является минимизация 

суммарной нормы ошибки прогнозирования. В некоторых случаях 

рассматриваются нормы, отличные от квадратичной, которые явля-

ются оптимальными при негауссовом распределении возмущений )(te

. При использовании критерия в виде (9) МОП соответствует оценке 

методом максимального правдоподобия при условии нормального 

распределения возмущений )(te . 

Наиболее привлекательной чертой метода является достаточно 

простой алгоритм оценки параметров (весовых коэффициентов) ИНС 

и независимость от возмущений (при условии их нормального рас-

пределения). В ряде случаев данный критерий не является абсолютно 

оптимальным, но в практических приложениях приводит к наилуч-

шей модели. 

В рамках данной работы для обучения ИНС применяется гради-

ентный метод. В основе градиентного метода, или метода наиско-
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рейшего спуска, лежит определение направления поиска как проти-

воположного направлению градиента,  т.е. 

 )( )()()()1( iiii G θθθ  .  (10) 

Сходимость метода существенно зависит от выбора шага )(i : 

при достаточно малом шаге обеспечивается уменьшение критерия на 

каждой итерации: ),(),( )()1( Ni

N

Ni

N
VV ZθZθ  . Применение метода к обу-

чению ИНС дает возможность организовать вычисления таким обра-

зом, чтобы рационально использовалась структура конкретной ИНС. 

В этом случае метод называется методом обратного распространения 

(ошибки), или обобщенным дельта-правилом. 

Для выбора шага алгоритма, определяющего скорость сходимо-

сти, могут применяться различные методы, в том числе и адаптив-

ные, хотя во многих приложениях используются методы с постоян-

ным шагом )(i . 

Независимо от выбора шага, градиентный метод может обеспе-

чить только линейную сходимость, т.е. *)1(*)1(
θθθθ   ii c , )1,0[c . 

Недостаточно высокая скорость сходимости алгоритма делает 

невозможным применение метода для решения задач в режиме ре-

ального времени. Тем не менее, метод может быть эффективно ис-

пользован в нейросетевых приложениях благодаря значительной 

простоте реализации, скромным требованиям к оперативной памяти 

и возможности использования естественной параллельности алго-

ритма при наличии специализированного аппаратного обеспечения. 

 

Практическая часть 

 

Данные, полученные в результате эксперимента с объектом 

управления, записаны в текстовый файл Lab_2_N.txt. Информация, 

содержащаяся в этом файле, должна использоваться для обучения 

ИНС. 

Изначально необходимо открыть txt-файл (рис. 2.4). 

Затем необходимо задать входные и выходные поля, а также их 

свойства. При этом нужно учитывать следующее. 
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Рисунок 2.4 – Окно подключения к источнику данных 

 

Синтезируемая ИНС состоит из входного, выходного и скрытых 

слоев.  Количество нейронов в первом и последнем слое зависит от 

того, сколько полей определено как входные и выходные. Поля, от-

меченные пометкой «не использовать», в обучении и тестировании 

ИНС применяться не будут. 

На вход ИНС должна подаваться информация в нормализован-

ном виде, т.е. числа в интервале [0,1]. Данный интервал называется 

интервалом допустимых значений и определяется функцией актива-

ции нейронов. Нормализация необходима для эффективного исполь-

зования интервала максимальной чувствительности функции актива-

ции. 

В Neural Network Wizard (NNW) реализована возможность вы-

бора метода нормализации. Возможными вариантами являются: ли-

нейная нормализация, экспоненциальная нормализация и авто-

нормализация, основанная на статистических характеристиках вы-

борки. При необходимости можно изменять параметры конкретного 

метода нормализации. Окно настройки свойств полей представлено 

на рис. 2.5. 
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Рисунок 2.5 – Окно настройки свойств полей 

 

Далее нужно указать количество скрытых слоев, количество 

нейронов в них и параметр активационной функции. 

Общего правила, позволяющего определить количество скры-

тых слоев, нет (см. теор. часть).  Обычно задается 1-3 скрытых слоев. 

Можно утверждать, что чем более нелинейная задача, тем больше 

скрытых слоев должно быть. 

В NNW все элементы предыдущего слоя связаны со всеми эле-

ментами последующего. Количество нейронов в каждом скрытом 

слое также необходимо задать. Общих правил определения количе-

ства нейронов нет, но необходимо, чтобы число связей между нейро-

нами было меньше количества примеров в обучающей выборке. 

Иначе ИНС потеряет способность к обобщению, а просто «запом-

нит» все примеры из обучающей выборки. Тогда при тестировании 

на примерах, присутствующих в обучающей выборке, ИНС будет 

демонстрировать прекрасные результаты, а на реальных данных – 

весьма плохие. 

Сигмоида применяется для обеспечения нелинейного преобра-

зования данных. В противном случае, ИНС сможет выделить только 

линейно разделимые множества. Чем выше параметр, тем больше ак-

тивационная функция походит на пороговую. Параметр сигмоиды 

подбирается эмпирически. Окно настройки параметров ИНС пред-

ставлено на рис. 2.6. 

 



 22 

 
Рисунок 2.6 – Окно настройки параметров ИНС 

 

После настройки параметров ИНС необходимо настроить пара-

метры обучения, учитывая следующие сведения. 

Все примеры, подаваемые на вход ИНС, делятся на 2 множества 

– обучающее и тестовое, поэтому требуется задать, сколько процен-

тов примеров будут использоваться в обучающей выборке. Записи, 

используемые для тестирования, выбираются случайно, но пропор-

ции сохраняются. 

Параметр «Скорость обучения» определяет амплитуду коррек-

ции весов на каждом шаге обучения. 

Параметр «Момент» определяет степень воздействия i ой кор-

рекции весов на 1i ую. 

Параметр «Распознана, если ошибка по примеру <» определяет 

максимальную величину ошибки, при которой пример считается 

распознанным. 

При установке флага напротив «Использовать тестовое множе-

ство как валидационное» обучение будет прекращено с выдачей со-

общения, как только ошибка на тестовом множестве начнет увеличи-

ваться. Это помогает избежать ситуации переобучения нейросети. 

Критерии остановки обучения определяют момент, когда обу-

чение будет закончено. 

Окно настройки параметров обучения представлено на рис. 2.7. 
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Рисунок 2.7 – Окно настройки параметров обучения 

 

После завершения настройки параметров обучения сети необ-

ходимо запустить процесс обучение. На рис. 2.8 представлено окно 

запуска обучения ИНС и отображения его динамики. 

В таблице над кнопкой можно наблюдать, как меняется ошибка 

обучения. В диаграмме отображается распределение ошибки. Зеле-

ные столбцы – ошибка на обучающей выборке, красные – на тесто-

вой выборке. Чем правее столбец, тем выше значение ошибки. Шка-

ла – от 0 до 1. Чем выше столбец, тем больше примеров с указанной 

ошибкой. 

На графиках «Распределение примеров в обучающей/тестовой 

выборке» можно отслеживать насколько результаты, предсказанные 

ИНС, совпадают со значениями в обучающей (слева) и тестовой 

(справа) выборках. Каждый пример обозначен на графике точкой. 

Если точка попадает на выделенную линию (диагональ), то ИНС 

предсказала результат с достаточно высокой точностью. Если точка 

находится выше диагонали, то ИНС недооценила его, ниже – пере-

оценила. Необходимо добиваться, чтобы точки располагались как 

можно ближе к диагонали. 
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Рисунок 2.8 – Окно отображения динамики обучения ИНС 

 

По завершению всех рассмотренных выше этапов можно ис-

пользовать синтезированную ИНС как модель объекта управления. 

На рис. 2.9 представлено окно, посредством которого осуществ-

ляется расчет на базе синтезированной ИНС. В наборе входных па-

раметров нужно ввести требуемые значения и нажать на кнопку 

«Расчет». В таблице «Рассчитанные параметры» появится результат. 

Необходимо иметь в виду, что проверять ИНС на числах, выходящих 

за границы обучаемой и тестовой выборки, некорректно. Например, 

если ИНС обучена складывать числа от 0 до 10, то необходимо и тес-

тировать ее на числах из этого диапазона. 
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Рисунок 2.9 – Окно расчета на базе синтезированной ИНС 

 

Задание на лабораторную работу 

 

1. Изучить материал теоретической части. 

2. Осуществить идентификацию объекта управления на базе 

синтеза ИНС прямого распространения, следуя указаниям из практи-

ческой части (файл с экспериментальными данными прилагается к 

методическому материалу). 

3. Изменяя параметры ИНС и обучения, определить характер 

влияния этих изменений на качество идентификации. Дать качест-

венную оценку установленным зависимостям. 

 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. не менее 5 скриншотов типа рис. 2.8, отражающих результа-

ты обучения при разных параметрах ИНС и обучения; 

2. пояснения к скриншотам; 

3. качественные оценки установленных зависимостей между 

параметрами ИНС (и ее обучения) и качеством идентификации; 

4. выводы, наличие которых определено заданием. 
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Лабораторная работа№3 

«Синтез САУ с применением методов вычислительного  

интеллекта» 

 

Цель работы 

 

Изучение структурно-функциональной организации много-

слойной сети прямого распространения (многослойного персептрона) 

и градиентного метода обучения, исследование влияния параметров 

обучения и структуры нейронной сети на качество идентификации. 

 

Теоретическая часть 

 

Искусственные нейронные сети (ИНС) – сети с конечным чис-

лом слоев из однотипных элементов – искусственных (формальных) 

нейронов с различными типами связей между слоями. При этом ко-

личество нейронов в слоях выбирается необходимым для обеспече-

ния заданного качества решения задачи, а число слоев нейронов как 

можно меньшим с целью уменьшения времени решения задачи. 

Каждый нейрон характеризуется своим текущим состоянием по 

аналогии с нервными клетками живого организма, которые могут 

быть возбуждены или заторможены. Он обладает группой синапсов – 

однонаправленных входных связей, соединенных с выходами других 

нейронов, а также имеет аксон – выходную связь данного нейрона, с 

которой сигнал (возбуждения или торможения) поступает на синап-

сы следующих нейронов. Структурно-функциональная организация 

формального нейрона представлена на рис. 3.1. 

Каждый синапс характеризуется величиной синаптической свя-

зи или ее весом wi, который по физическому смыслу эквивалентен 

электрической проводимости. 
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Рисунок 3.1 – Структурно-функциональная организация искусствен-

ного нейрона 

 

Текущее состояние нейрона определяется как взвешенная сум-

ма его входов: 

 



n

i

ii wxS
1

,  (1) 

где n  – число входов нейрона; ix  – значение i го входа нейрона; iw  – 

вес i го синапса. 

Выход нейрона есть функция его состояния 

 )()( 0 SfwSfY  ,  (2) 

где f  – некоторая функция, называемая активационной; 0w – «нейрон-

ное смещение», вводимое для инициализации сети, – подключается к 

неизменяемому входу «+1» (на рис. 1 такой вход не показан). 

Активационная функция может иметь различный вид, как пока-

зано на рис. 3.2. 

 
Рисунок 3.2 – а) ступенчатая функция; б) линейный порог; 

в) гиперболический тангенс; г) сигмоида 
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Одной из наиболее распространенных является нелинейная 

функция с насыщением, так называемая логистическая функция или 

сигмоида (т.е. функция s-образного вида): 

 
xe

xf



1

1
)( . (3) 

инию на уровне 0.5, при увели-

и-

ничного скачка с порогом T в точке x=0. Из выражения для сигмоиды 

очевидно, что выходное значение нейрона лежит в диапазоне [0,1]. 

Одно из ценных свойств логистической функции – простое выраже-

ние для ее производной: 

 ))(1)(()( xfxfxf   .  (4) 

Следует отметить, что логистическая функция является глад-

кой, что используется в некоторых алгоритмах обучения. Кроме того, 

она обладает свойством усиливать слабые сигналы лучше, чем силь-

ные, и предотвращает насыщение от сильных сигналов, так как они 

соответствуют областям аргументов, где сигмоида имеет пологий на-

клон. 

ИНС может рассматриваться как направленный граф с взве-

шенными дугами, в котором искусственные нейроны являются узла-

ми. По архитектуре связей ИНС могут быть сгруппированы в два 

класса: сети прямого распространения, в которых графы не имеют 

петель, и рекуррентные сети, или сети с обратными связями. 

В наиболее распространенном семействе сетей первого класса, 

называемых многослойными персептронами, нейроны расположены 

слоями, связанными однонаправлено. Синтез сети именно такого ти-

па рассматривается в данной работе. 

Сети прямого распространения являются статическими в том 

смысле, что на заданный вход они вырабатывают одну совокупность 

выходных значений, не зависящих от предыдущего состояния сети. 

Функциональные особенности нейронов и способ их объедине-

ния в сетевую структуру обуславливают ту или иную парадигму 

ИНС. Для решения задач идентификации и управления наиболее 

адекватными, без сомнения, являются многослойные ИНС (МНС) 

прямого действия или многослойные персептроны (МСП). При про-

ектировании МНС нейроны объединяются в слои, каждый их кото-
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рых обрабатывает вектор сигналов от предыдущего слоя (или вход-

ной вектор). Минимальной реализацией является двухслойная ИНС, 

состоящая из входного (распределительного), промежуточного 

(скрытого) и выходного слоя. При подсчете числа  слоев входной 

слой обычно не учитывается, так как служит лишь для распределения 

входных сигналов по нейронам последующего слоя. На рис. 3.3 

представлена структурная схема двухслойной ИНС прямого распро-

странения. Сигналы в сети распространяются от входа к выходу, свя-

зи между нейронами одного слоя и обратные связи отсутствуют. 
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Рисунок 3.3 – Структурная схема двухслойной нейронной сети 

 

Реализация модели двухслойной ИНС прямого распространения 

имеет следующее математическое представление: 
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где n  – размерность вектора входов   нейронной сети; 

hn  – число нейронов в скрытом слое; 

θ  – вектор настраиваемых параметров нейронной сети, вклю-

чающий весовые коэффициенты и нейронные смещения ( ijjl Ww , ); 

)(xf j  – активационная функция нейронов скрытого слоя; 

)(xFi  – активационная функция нейронов выходного слоя. 

Рассмотрим функционирование МНС как совокупности взаимо-

связанных элементарных элементов (нейронов) с математической 

точки зрения. Каждый структурный элемент МНС получает на входе 

вектор сигналов φ, вычисляет его скалярное произведение на вектор 

весовых коэффициентов нейрона W  и некоторую функцию F  в вы-
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ходной сигнал y . Результат поступает на входы других нейронов или 

на выход. Таким образом, нейронные сети вычисляют суперпозиции 

функций одного переменного и их линейные комбинации. Для обос-

нования возможности использования МНС в качестве моделей дина-

мических систем нужно получить ответ на вопрос: можно ли произ-

вольную непрерывную функцию n  переменных получить с помощью 

операций сложения, умножения и суперпозиции функций одного пе-

ременного? 

В серии работ А.Н. Колмогорова и В.И. Арнольда решена сле-

дующая математическая проблема (составляющая существо трина-

дцатой проблемы Гильберта): любую непрерывную функцию n  пе-

ременных можно получить с помощью операций сложения, умноже-

ния и суперпозиции из непрерывных функций одного переменного. 

На основе этих работ доказан ряд теорем об аппроксимации непре-

рывных функций многих переменных ИНС с использованием прак-

тически произвольной функции одного переменного. Помимо под-

тверждения общих аппроксимирующих свойств МНС необходимо 

получить ответы на ряд частных вопросов, касающихся структуры 

сети: 

Сколько скрытых слоев должна содержать нейронная сеть? 

Сколько нейронов должно быть включено в каждый слой? 

Какой тип активационной функции должен быть выбран? 

По мнению некоторых исследователей, любая непрерывная не-

линейная функция может быть аппроксимирована с достаточной 

точностью ИНС с одним скрытым слоем, содержащим нейроны с 

сигмоидальными (или типа «гиперболический тангенс») функциями 

активации, и выходным слоем, содержащим нейроны с линейной ак-

тивационной функцией. Сделаны попытки исследования влияния 

числа нейронов в скрытом слое на аппроксимирующие свойства се-

ти, однако полученный результат практически невозможно приме-

нить на практике. 

В настоящей работе рассматривается минимальная реализация 

МНС в соответствии с выражением (5) и активационными функция-

ми типа «сигмоида» для нейронов в скрытом и выходном слоях. 

Возможно, репрезентативные способности МНС могут быть улучше-

ны путем введения дополнительных скрытых слоев, особенно в слу-

чае моделирования сложных взаимосвязей. Однако усложнение 
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структуры МНС приводит к значительным трудностям при практи-

ческой реализации, обучении и последующем анализе. Это объясняет 

факт использования именно минимальной реализации МНС в боль-

шинстве технических приложений. 

Предположим, что в результате проведения эксперимента и 

предварительной обработки данных получено некоторое множество 

  NttytuN ,1)],(),([ Z ,  (6) 

где )(),( tytu  – соответственно входы и выходы системы, N  – число 

дискретных отсчетов. Допустим также, сто выбрана некоторая мо-

дельная структура 

 )()|(ˆ)( tetyty  θ . (7) 

В соответствии с общей схемой реализации процедуры иденти-

фикации следующим этапом является оценка параметров выбранной 

модельной структуры. При использовании нейросетевых модельных 

структур этот этап представляет собой настройку весовых коэффи-

циентов сети в результате реализации процедуры обучения на мно-

жестве примеров. Обучение представляет собой отображение множе-

ства экспериментальных данных на множество параметров нейросе-

тевой модели 

 θZ ˆN   (8) 

с целью получения оптимального, в силу некоторого критерия, про-

гноза выходного сигнала ŷ . Традиционно используемым критерием 

является среднеквадратичная ошибка прогнозирования 
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Данный подход относится к классу методов ошибки прогнози-

рования (МОП), так как основной задачей является минимизация 

суммарной нормы ошибки прогнозирования. В некоторых случаях 

рассматриваются нормы, отличные от квадратичной, которые явля-

ются оптимальными при негауссовом распределении возмущений )(te

. При использовании критерия в виде (9) МОП соответствует оценке 

методом максимального правдоподобия при условии нормального 

распределения возмущений )(te . 

Наиболее привлекательной чертой метода является достаточно 

простой алгоритм оценки параметров (весовых коэффициентов) ИНС 

и независимость от возмущений (при условии их нормального рас-
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пределения). В ряде случаев данный критерий не является абсолютно 

оптимальным, но в практических приложениях приводит к наилуч-

шей модели. 

В рамках данной работы для обучения ИНС применяется гради-

ентный метод. В основе градиентного метода, или метода наиско-

рейшего спуска, лежит определение направления поиска как проти-

воположного направлению градиента,  т.е. 

 )( )()()()1( iiii G θθθ  .  (10) 

Сходимость метода существенно зависит от выбора шага )(i : 

при достаточно малом шаге обеспечивается уменьшение критерия на 

каждой итерации: ),(),( )()1( Ni

N

Ni

N
VV ZθZθ  . Применение метода к обу-

чению ИНС дает возможность организовать вычисления таким обра-

зом, чтобы рационально использовалась структура конкретной ИНС. 

В этом случае метод называется методом обратного распространения 

(ошибки), или обобщенным дельта-правилом. 

Для выбора шага алгоритма, определяющего скорость сходимо-

сти, могут применяться различные методы, в том числе и адаптив-

ные, хотя во многих приложениях используются методы с постоян-

ным шагом )(i . 

Независимо от выбора шага, градиентный метод может обеспе-

чить только линейную сходимость, т.е. *)1(*)1(
θθθθ   ii c , )1,0[c . 

Недостаточно высокая скорость сходимости алгоритма делает 

невозможным применение метода для решения задач в режиме ре-

ального времени. Тем не менее, метод может быть эффективно ис-

пользован в нейросетевых приложениях благодаря значительной 

простоте реализации, скромным требованиям к оперативной памяти 

и возможности использования естественной параллельности алго-

ритма при наличии специализированного аппаратного обеспечения. 

 

Практическая часть 

 

Данные, полученные в результате эксперимента с объектом 

управления, записаны в текстовый файл Lab_2_N.txt. Информация, 

содержащаяся в этом файле, должна использоваться для обучения 

ИНС. 

Изначально необходимо открыть txt-файл (рис. 3.4). 
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Рисунок 3.4 – Окно подключения к источнику данных 

 

Затем необходимо задать входные и выходные поля, а также их 

свойства. При этом нужно учитывать следующее. 

Синтезируемая ИНС состоит из входного, выходного и скрытых 

слоев.  Количество нейронов в первом и последнем слое зависит от 

того, сколько полей определено как входные и выходные. Поля, от-

меченные пометкой «не использовать», в обучении и тестировании 

ИНС применяться не будут. 

На вход ИНС должна подаваться информация в нормализован-

ном виде, т.е. числа в интервале [0,1]. Данный интервал называется 

интервалом допустимых значений и определяется функцией актива-

ции нейронов. Нормализация необходима для эффективного исполь-

зования интервала максимальной чувствительности функции актива-

ции. 

В Neural Network Wizard (NNW) реализована возможность вы-

бора метода нормализации. Возможными вариантами являются: ли-

нейная нормализация, экспоненциальная нормализация и авто-

нормализация, основанная на статистических характеристиках вы-

борки. При необходимости можно изменять параметры конкретного 

метода нормализации. Окно настройки свойств полей представлено 

на рис. 3.5. 
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Рисунок 3.5 – Окно настройки свойств полей 

 

Далее нужно указать количество скрытых слоев, количество 

нейронов в них и параметр активационной функции. 

Общего правила, позволяющего определить количество скры-

тых слоев, нет (см. теор. часть).  Обычно задается 1-3 скрытых слоев. 

Можно утверждать, что чем более нелинейная задача, тем больше 

скрытых слоев должно быть. 

В NNW все элементы предыдущего слоя связаны со всеми эле-

ментами последующего. Количество нейронов в каждом скрытом 

слое также необходимо задать. Общих правил определения количе-

ства нейронов нет, но необходимо, чтобы число связей между нейро-

нами было меньше количества примеров в обучающей выборке. 

Иначе ИНС потеряет способность к обобщению, а просто «запом-

нит» все примеры из обучающей выборки. Тогда при тестировании 

на примерах, присутствующих в обучающей выборке, ИНС будет 

демонстрировать прекрасные результаты, а на реальных данных – 

весьма плохие. 

Сигмоида применяется для обеспечения нелинейного преобра-

зования данных. В противном случае, ИНС сможет выделить только 

линейно разделимые множества. Чем выше параметр, тем больше ак-

тивационная функция походит на пороговую. Параметр сигмоиды 

подбирается эмпирически. Окно настройки параметров ИНС пред-

ставлено на рис. 3.6. 

 



 35 

 
Рисунок 3.6 – Окно настройки параметров ИНС 

 

После настройки параметров ИНС необходимо настроить пара-

метры обучения, учитывая следующие сведения. 

Все примеры, подаваемые на вход ИНС, делятся на 2 множества 

– обучающее и тестовое, поэтому требуется задать, сколько процен-

тов примеров будут использоваться в обучающей выборке. Записи, 

используемые для тестирования, выбираются случайно, но пропор-

ции сохраняются. 

Параметр «Скорость обучения» определяет амплитуду коррек-

ции весов на каждом шаге обучения. 

Параметр «Момент» определяет степень воздействия i ой кор-

рекции весов на 1i ую. 

Параметр «Распознана, если ошибка по примеру <» определяет 

максимальную величину ошибки, при которой пример считается 

распознанным. 

При установке флага напротив «Использовать тестовое множе-

ство как валидационное» обучение будет прекращено с выдачей со-

общения, как только ошибка на тестовом множестве начнет увеличи-

ваться. Это помогает избежать ситуации переобучения нейросети. 

Критерии остановки обучения определяют момент, когда обу-

чение будет закончено. 

Окно настройки параметров обучения представлено на рис. 3.7. 
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Рисунок 3.7 – Окно настройки параметров обучения 

 

После завершения настройки параметров обучения сети необ-

ходимо запустить процесс обучение. На рис. 8 представлено окно за-

пуска обучения ИНС и отображения его динамики. 

В таблице над кнопкой можно наблюдать, как меняется ошибка 

обучения. В диаграмме отображается распределение ошибки. Зеле-

ные столбцы – ошибка на обучающей выборке, красные – на тесто-

вой выборке. Чем правее столбец, тем выше значение ошибки. Шка-

ла – от 0 до 1. Чем выше столбец, тем больше примеров с указанной 

ошибкой. 

На графиках «Распределение примеров в обучающей/тестовой 

выборке» можно отслеживать насколько результаты, предсказанные 

ИНС, совпадают со значениями в обучающей (слева) и тестовой 

(справа) выборках. Каждый пример обозначен на графике точкой. 

Если точка попадает на выделенную линию (диагональ), то ИНС 

предсказала результат с достаточно высокой точностью. Если точка 

находится выше диагонали, то ИНС недооценила его, ниже – пере-

оценила. Необходимо добиваться, чтобы точки располагались как 

можно ближе к диагонали. 

 



 37 

 
Рисунок 3.8 – Окно отображения динамики обучения ИНС 

 

По завершению всех рассмотренных выше этапов можно ис-

пользовать синтезированную ИНС как модель объекта управления. 

На рис. 3.9 представлено окно, посредством которого осуществ-

ляется расчет на базе синтезированной ИНС. В наборе входных па-

раметров нужно ввести требуемые значения и нажать на кнопку 

«Расчет». В таблице «Рассчитанные параметры» появится результат. 

Необходимо иметь в виду, что проверять ИНС на числах, выходящих 

за границы обучаемой и тестовой выборки, некорректно. Например, 

если ИНС обучена складывать числа от 0 до 10, то необходимо и тес-

тировать ее на числах из этого диапазона. 
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Рисунок 3.9 – Окно расчета на базе синтезированной ИНС 

 

Задание на лабораторную работу 

 

4. Изучить материал теоретической части. 

5. Осуществить идентификацию объекта управления на базе 

синтеза ИНС прямого распространения, следуя указаниям из практи-

ческой части (файл с экспериментальными данными прилагается к 

методическому материалу). 

6. Изменяя параметры ИНС и обучения, определить характер 

влияния этих изменений на качество идентификации. Дать качест-

венную оценку установленным зависимостям. 

 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

5. не менее 5 скриншотов типа рис. 8, отражающих результаты 

обучения при разных параметрах ИНС и обучения; 

6. пояснения к скриншотам; 

7. качественные оценки установленных зависимостей между 

параметрами ИНС (и ее обучения) и качеством идентификации; 

8. выводы, наличие которых определено заданием. 
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Лабораторная работа№4 

Разработка программного обеспечения нечеткого регулятора 

 

Цель работы 

 

Изучение генетического алгоритма, модифицированного реали-

зацией в нем регулярного поиска локальных экстремумов на базе ме-

тода деформируемого многогранника; исследование влияния пара-

метров инициализации  алгоритма на скорость и вероятность полу-

чения требуемого решения. 

 

Теоретическая часть 

 

Генетические алгоритмы (ГА) применяются для решения мно-

гих конкретных научных и технических проблем, но самое популяр-

ное приложение генетических алгоритмов – оптимизация многопа-

раметрических функций. Эффективность ГА определяется их спо-

собностью манипулировать одновременно многими параметрами, 

что является крайне необходимым в решении многих прикладных за-

дач, включая проектирование интегральных схем, настройку пара-

метров алгоритмов, поиск решений нелинейных дифференциальных 

уравнений и т. д. 

Эффективность применения ГА зависит от характеристик зада-

чи. Если пространство поиска в задаче небольшое, то решение можно 

найти методом полного перебора и применение ГА не требуется. Ес-

ли пространство гладкое и унимодальное, то любой градиентный ал-

горитм будет эффективнее ГА. Если существует дополнительная ин-

формация о пространстве поиска, то методы поиска, использующие 

эвристики, часто превосходят ГА. Область применения ГА – задачи с 

большим пространством поиска решений и отсутствием эвристиче-

ской информации. 

Кроме того, эффективность ГА зависит от характеристик мето-

да кодировки решений, выбора генетических операторов и значений 

инициализирующих параметров. 

Оценим возможности применения ГА для решения задач опти-

мизации параметров элементов систем автоматического управления 

(САУ). 
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Опыт многих исследователей алгоритмов управления показал, 

что для простых одноконтурных САУ с линейными регуляторами за-

дачи оптимизации, как правило, являются одноэкстремальными. Од-

нако для сложных многоконтурных САУ и систем управления с ней-

роконтроллерами характерно наряду с глобальным наличие большо-

го числа локальных экстремумов. Кроме того, локальные экстрему-

мы появляются и при введении ограничений на пространство поиска. 

Для решения одноэкстремальных задач оптимизации существу-

ет достаточное число градиентных и численных методов. Одним из 

них является метод деформируемого многогранника Нелдера-Мида. 

При оптимизации одноконтурной САУ с ПИ-регулятором примене-

ние метода позволяет устойчиво находить оптимальные значения на-

строечных параметров pK  и iK  для функции цели вида 

 min)1(),,,( 0,   aItKKF ymip ,  (1) 

где 

 
pt

ym dttyI
0

, )(   (2) 

– интеграл по модулю регулируемой величины )(ty  на интервале 

времени переходного процесса ðt ;  ,0  – соответственно, заданная и 

текущая степень затухания переходного процесса регулирования; a  – 

масштабный коэффициент, учитывающий вес штрафной функции. 

Применение метода деформируемого многогранника для опти-

мизации двухконтурной САУ с дифференциатором и САУ с нейро-

контроллерами различной структуры приводит к неоднозначности 

решения. В каждом случае результаты зависят от выбранных началь-

ных координат. Из этого следует вывод о многоэкстремальности по-

добных задач, и для их решения требуются методы глобальной оп-

тимизации. 

В настоящее время наиболее предпочтительными методами 

многоэкстремальной оптимизации являются ГА, реализующие по-

стулаты теории эволюции и опыта селекции растений и животных. 

Стратегия поиска оптимального решения в ГА опирается на гипотезу 

селекции: чем выше приспособленность особи, тем выше вероят-

ность того, что у потомков, полученных с ее участием, признаки, оп-

ределяющие приспособленность, будут выражены еще сильнее. 
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Если принять, что каждая особь популяции является точкой в 

координатном пространстве оптимизационной задачи  liiii xxxX ,...,, 21 , а 

приспособленность особи – соответствующим значением функции 

цели )( iXf , то популяцию особей можно рассматривать как множест-

во координатных точек в пространстве, а процесс эволюции – как 

движение этих точек в сторону оптимальных значений целевой 

функции. 

Следует отметить, что классический ГА находит глобальный 

экстремум в вероятностном смысле. И эта вероятность прямо зависит 

от числа особей в популяции. При оптимизации сложных многокон-

турных и многосвязных систем регулирования и аналогичных систем 

с нейроконтроллерами ГА (в частности, диплоидная версия ГА) с 

достаточно высокой вероятностью находят глобальный экстремум. 

Однако вычисление функции цели, как правило, требует значитель-

ных вычислительных ресурсов, что существенно сказывается на об-

щем времени расчета решения. 

Особенностью ГА является то, что ни один из генетических 

операторов (кроссовер, мутация, инверсия) в процессе генерирования 

потомков не опирается на знание локального рельефа поверхности 

отклика функции цели. Формирование потомков генетическими опе-

раторами происходит случайным образом, и поэтому нет гарантии, 

что найденные решения будут лучше родительских. Следовательно, в 

процессе эволюции встречается немалое число «неудачных» потом-

ков, которые увеличивают число обращений к функции цели и, тем 

самым, увеличивают время поиска глобального экстремума. 

Кроме того, ГА находят оптимальное решение только внутри 

заданного диапазона поиска. Поэтому диапазоны поиска и число 

особей в популяции требуется задавать с большим запасом, что так-

же увеличивает время решения. 

Перечисленные особенности сдерживают широкое применение 

ГА в инженерной практике. Однако потребность в таких алгоритмах 

для решения прикладных задач сравнительно небольшой размерно-

сти постоянно растет, особенно в связи с намечающейся тенденцией 

внедрения в системы управления нейросетевых технологий. 

В настоящей лабораторной работе для решения задачи оптими-

зации предлагается использовать модифицированный ГА (МГА), 

применение которого обеспечивает возможность нахождения гло-
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бального экстремума с требуемой вероятностью при существенно 

меньшем, по сравнению с диплоидным ГА, числом обращений к 

функции цели. 

МГА содержит в себе генетические качества статистической се-

лекции популяции поисковых точек. Для исключения «неудачных» 

потомков в нем реализована процедура регулярного поиска локаль-

ных экстремумов с использованием метода деформируемого много-

гранника. При смене поколений в алгоритме заложена рекомендуе-

мая во многих источниках 10-процентная замена «неперспективных» 

особей (элиминирование). 

На рис. 4.1 приведена факсимильная копия программы МГА для 

Mathcad, в которой реализованы процедуры статистического задания 

особей в популяции, сортировки и элиминирования неперспективных 

особей, вероятностной селекции группы особей для целей осуществ-

ления регулярного поиска локальных экстремумов, операций регу-

лярного поиска локальных экстремумов, а также процедур заверше-

ния работы алгоритма. 

 Для инициализации алгоритма необходимо установить: раз-

мерность задачи оптимизации N , численность особей в популяции  , 

точность решения задачи   и значения матрицы D , определяющие 

границы интервалов значений координат оптимизируемых векторов 

популяции. 

В общем случае, МГА почти в два раза меньше обращается к 

функции цели по сравнению с диплоидной версией ГА, что вдвое по-

вышает оперативность получения решения. Кроме того, в процессе 

регулярного поиска МГА способен найти глобальный экстремум за 

пределами заданного диапазона. Перечисленные особенности позво-

ляют заключить, что применение модифицированного ГА в задачах 

многоэкстремальной оптимизации (в частности, параметров элемен-

тов САУ) является более эффективным, чем использование его клас-

сической версии. 
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Рисунок 4.1 – Текст программы МГА для Mathcad 
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Практическая часть 

 

МГА реализован в программном средстве Global Minimum Re-

searcher (GMR). Скриншот основного окна GMR представлен на рис. 

2. 

 

 
Рисунок 4.2 – Основное окно приложения «GMR» 

 

На панели «Начальные условия» расположены: 

1. окно «Размерность задачи оптимизации», которое служит для 

отображения числа оптимизируемых параметров; 

2. окно «Численность особей в популяции», через которое вво-

дится и отображается количество картежей типа <Решение | Значение 

функции цели>, обрабатываемых в процессе расчета решения; 

3. окно «Точность решения задачи», необходимое для ввода и 

отображение величины, определяющей максимально допустимое 

рассогласование значений целевой функции, соответствующих полу-

ченным в результате работы программы решениям; 

4. таблица «Интервалы значений», посредством которой вво-

дятся и отображаются идентификаторы и интервалы допустимых 

значений оптимизируемых параметров. 

Размерность задачи оптимизации определяется GMR автомати-

чески, исходя из числа параметров функции, представленной про-
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граммным блоком, скомпилированным в динамически присоединяе-

мую библиотеку (DLL). 

Численность особей в популяции (ЧОП) влияет на расчет реше-

ния неоднозначно. В случае если оптимизируемая функция является 

унимодальной, то ЧОП влияет только на скорость сходимости. Если 

оптимизируется многоэкстремальная функция, то, помимо скорости 

сходимости, в зависимости от ЧОП находится еще и вероятность на-

хождения глобального экстремума. 

Точность решения задачи определяет размер окрестности гло-

бального минимума, в которой по окончании работы программы 

должны находиться все точки n мерного пространства задачи опти-

мизации, соответствующие особям эволюционировавшей популяции. 

Параметр, определяющий область допустимых значений опти-

мизируемых переменных, влияет на расчет решения в комплексе с 

ЧОП и определяет границы области, в которой строится некоторая 

поверхность при формировании начальной популяции. При этом 

ЧОП определяет уровень разреженности точек поверхности. Чем 

больше размер области допустимых значений и количество точек, 

образующих в ней поверхность, тем более полная информация о ха-

рактере целевой функции передается программе до непосредственно-

го начала поиска. 

Важно отметить, что программа GMR способна находить гло-

бальный экстремум, даже в том случае, если он находится за преде-

лами области, определенной пользователем. 

На панели «Полученное решение» расположена таблица ото-

бражения оптимальных значений параметров. 

На панелях «Начальная популяция» и «Эволюционировавшая 

популяция» расположены таблицы отображения решений с соответ-

ствующими значениями функции цели. 

Рассмотрим порядок работы с приложением GMR. 

Изначально необходимо создать динамически присоединяемую 

библиотеку, в которую должен быть скомпилирован код, представ-

ляющий функцию. 

Для создания библиотеки в интегрированной среде разработки 

C++ Builder необходимо выполнить следующие действия. 

1. Выполнить команду File | New | Other и выбрать пиктограмму 

Dynamic-link Library (либо DLL Wizard). Сделать в диалого-
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вом окне установки, показанные на рис. 4.3. Откроется окно 

Редактора Кода. 

 

 
Рисунок 4.3 – Окно задания опций создания DLL 

 

2. Удалить из текста комментарий. 

3. Вставить перед описанием DllEntryPoint директиву включе-

ния головного файла: 

 #include "MGA.h" (имя файла может быть другим). Файла 

MGA.h пока нет. Он будет создан позже. Также, при необхо-

димости, нужно добавить в файл реализации директивы 

включения заголовочных файлов стандартных библиотек. 

4. Вставить после описания DllEntryPoint описание функции 

Opt (в рассматриваемом примере операторы тела функции 

возвращают значение по формуле 2

1

2

0 xxy  ). 

5. Сохранить модуль и проект. 

В результате рассмотренных действий файл MGA.cpp (имя 

файла может быть другим) примет следующий вид: 

#include <windows.h> 

#include <Math.h> 

#include <Math.hpp> 

#pragma argsused 

#include "MGA.h" 

int WINAPI DllEntryPoint(HINSTANCE hinst, unsigned long 

reason, void* lpReserved) 

{ 

 return 1; 

} 

//--------------------------------------------------------------------------- 

 

double Opt (double * x) 

{ 
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double y=pow(x[0],2)+pow(x[1],2); 

return y; 

} 

6. Выполнить команду File | New | Other и выбрать пиктограмму 

Header File. Откроется окно Редактора Кода. 

7. Записать в файл следующий код: 

extern "C" double __declspec(dllexport) Opt (double * x); 

8. Сохранить файл с именем MGA.h. 

9. Выполнить команду Project | Build MGA. В результате будет 

создан файл MGA.dll. 

Перед компиляцией рекомендуется выключить опции «Build 

with runtime packages» и «Dynamic RTL» на вкладках Project | Options 

| Packages и Project | Options | Linker | Linking соответственно. Это 

обеспечит возможность использования библиотеки в системе, где не 

установлены стандартные библиотеки (пакеты) C++ Builder. 

Скомпилированную библиотеку нужно подключить к GMR, 

выполнив команду Функция | Загрузить DLL. 

Затем нужно определить идентификаторы и диапазоны допус-

тимых значений оптимизируемых параметров, вызвав двойным 

щелчком мыши по таблице «Интервалы значений» окно, представ-

ленное на рис. 4.4. 

 

 
Рисунок 4.4 – Окно настройки свойств оптимизируемых параметров 

 

После этого становится активной команда Решение | Рассчи-

тать. Далее, настроив оставшиеся параметры, необходимо рассчитать 

решение. 

Следует отметить, что скорость получения решения оценивает-

ся количеством итераций (эпох), обеспечивающим сходимость точек, 

соответствующих особям популяции, в окрестности минимума. 
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Задание на лабораторную работу 

 

1. Изучить генетический алгоритм, модифицированный реали-

зацией в нем регулярного поиска локальных экстремумов на базе ме-

тода деформируемого многогранника. 

2. Создать динамически присоединяемую библиотеку, скомпи-

лировав в нее программный код, представляющий многоэкстремаль-

ную функцию 2-4 переменных. 

3. Найти глобальный минимум выбранной функции с использо-

ванием программного средства GMR. 

4. Качественно оценить влияние численности особей в популя-

ции и размеров области поиска на вероятность нахождения глобаль-

ного минимума и скорость получения решения. Сделать выводы. 

 

Отчет должен содержать цель работы, задание и практическую 

часть, включающую: 

1. скриншот главного окна программного средства GMR, ото-

бражающего начальные условия и результат решения поставленной в 

рамках работы задачи; 

2. листинг файла реализации *.cpp, содержащего описание це-

левой функции; 

3. пояснения к скриншоту и листингу; 

4. качественные оценки влияния параметров инициализации ал-

горитма на процесс и результат решения; 

5. выводы, наличие которых определено заданием. 
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Лабораторная работа № 5 

Моделирование работы нечеткого регулятора с одним входом 

 

Краткие теоретические сведения 

 

Нечеткий регулятор (в англоязычной литературе fuzzy 

controller) является элементом систем автоматического управления, 

использующим принципы нечеткой логики (в англоязычной литера-

туре fuzzy logic). Нечеткий регулятор может иметь более одного вхо-

да. В рамках данной работы рассмотрим нечеткий регулятор с одним 

входом. 

В своих работах, посвященных нечеткой логике, Лотфи Заде 

предложил использование логических правил для задания поведения 

нечеткого регулятора. Форма записи правил для нечеткого регулято-

ра с одним входом выглядит следующим образом: 

 

ЕСЛИ (условие №1) ТО (действие №1)  

ЕСЛИ (условие №2) ТО (действие №2)  

ЕСЛИ (условие №3) ТО (действие №3)  

… 

ЕСЛИ (условие №N) ТО (действие №N)  

 

Составление набора правил является важной часть процесса 

проектирования регулятора. Рассмотрим процесс составления набора 

правил на примере задачи разработки регулятора для системы управ-

ления подводного робота, осуществляющего горизонтальное пере-

мещение. Управляемым параметром является положение робота. 

Управление производится по ошибке – разнице между задающим 

воздействием и сигналом в цепи обратной связи. Общий вид схемы 

системы управления показан на рисунке 1. 
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Рисунок 1 Схема системы автоматического управления 

 

Для достижения поставленных задач будем использовать сле-

дующий набор правил: 

 

ЕСЛИ оставшееся расстояние – слишком малое ТО двигать-

ся обратно (осуществлять реверс) 

ЕСЛИ оставшееся расстояние – достаточное ТО остано-

виться 

ЕСЛИ оставшееся расстояние – малое ТО двигаться вперед 

ЕСЛИ оставшееся расстояние – большое ТО двигаться впе-

ред 

ЕСЛИ оставшееся расстояние – очень большое ТО двигаться 

вперед ускоренно 

 

Следует обратить внимание на то, что правила используют лин-

гвистические категории, такие как «низкий», «высокий» и т.п. вместо 

численных значений. 

При подобной настройке нечеткий регулятор будет работать 

следующим образом. Так называемый «четкий» сигнал поступает на 

вход регулятора. Этот сигнал подается на входные функции принад-

лежности (в англоязычной литературе «antecedent membership func-

tions», «antecedents»), определяющие степень принадлежности сигна-

ла к одной из лингвистических категорий. В нашем случае мы имеет 

три такие категории – «ошибка низкая», «ошибка средняя» и «ошиб-

ка высокая». 

Вид функций принадлежности определяется при разработке ре-

гулятора. Рассмотрим некоторые виды функций принадлежности. 
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Треугольная функция принадлежности. Выходной сигнал 

функции, как очевидно из еѐ названия, имеет вид треугольника. На 

рисунке 2 показаны выходные сигналы трѐх треугольных функций 

принадлежности. На рисунке 3 показано подключение блоков Trian-

gular MF пакета Simulink, моделирующих работу треугольных функ-

ций принадлежности. 

 
Рисунок 2 Выходной сигнал трѐх треугольных функций принадлеж-

ности 

 

 
Рисунок 3 Подключение блоков Triangular MF пакета Simulink, моде-

лирующих работу треугольных функций принадлежности 
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Трапецеидальная функция принадлежности. Выходной сиг-

нал функции имеет вид трапеции. На рисунке 4 показаны выходные 

сигналы трѐх трапецеидальных функций принадлежности. На рисун-

ке 5 показано подключение блоков Trapezoidal MF пакета Simulink, 

моделирующих работу трапецеидальных функций принадлежности. 

 

 
Рисунок 4 Выходной сигнал трѐх трапецеидальных функций принад-

лежности 

 

 
Рисунок 5 Подключение блоков Trapezoidal MF пакета Simulink, мо-

делирующих работу трапецеидальных функций принадлежности 
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Гауссова функция принадлежности. Выходной сигнал функ-

ции имеет вид гауссовой кривой. На рисунке 6 показаны выходные 

сигналы трѐх гауссовых функций принадлежности. На рисунке 7 по-

казано подключение блоков Gaussian MF пакета Simulink, модели-

рующих работу гауссовых функций принадлежности. 

 

 
Рисунок 6 Выходной сигнал трѐх гауссовых функций принадлежно-

сти 

 

 
Рисунок 7 Подключение блоков Gaussian MF пакета Simulink, моде-

лирующих работу гауссовых функций принадлежности 
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Сигмоидная функция принадлежности. Выходной сигнал 

функции имеет вид сигмоиды. На рисунке 8 показаны выходные сиг-

налы трѐх сигмоидных принадлежности. На рисунке 7 показано под-

ключение блоков Sigmoidal MF пакета Simulink, моделирующих ра-

боту сигмоидных функций принадлежности. 

 

 
Рисунок 8 Выходной сигнал трѐх сигмоидных функций принадлеж-

ности 

 

 
Рисунок 9 Подключение блоков Sigmoidal MF пакета Simulink, моде-

лирующих работу сигмоидных функций принадлежности 
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На выходе функций принадлежности мы имеем несколько сиг-

налов (по одному сигналу на каждую функцию; число сигналов 

должно быть равно числу лингвистических категорий, использован-

ных в разработанном наборе правил). Далее данные передаются на 

заключительные функции принадлежности (в англоязычной литера-

туре «consequent membership functions»). Эти функции могут иметь 

тот же вид что и входные функции принадлежности. Основное отли-

чие работы с ними состоит в том, что в случае с заключительными 

функциями принадлежности нас интересует площадь образованной 

ими фигуры и еѐ центр масс. Поступающий на вход такой функции 

сигнал обрезает еѐ или масштабирует еѐ (см. рисунок 10). 

 
Рисунок 10 Сигнал, поступивший на вход заключительной функции 

принадлежности, обрезает еѐ верхнюю часть; площадь и центр масс 

полученной фигуры являются выходными параметрами функции 

 

Следующим и заключительным этапом обработки сигналов в 

нечетком регуляторе является дефаззификация. На этом этапе все 

полученные на прошлом этапе фигуры складываются и определяется 

их общий центр масс (см. рисунок 11) 

 
Рисунок 11 Сложение сигналов, нахождение центра масс 
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2. Методика выполнения работы 

 

Для выполнения работы требуется разработать структуру не-

четкого регулятора и интегрировать регулятор в систему управления 

подводным роботом, осуществляющим горизонтальное перемеще-

ние. 

Динамику робота, при перемещении вдоль горизонтально оси, 

можно описать следующими уравнениями: 









CF

Fxxm




.     (1) 

где x  - положение робота, m  - масса робота,   - коэффициент лобо-

вого сопротивления, F  - сила тяги, создаваемая гребным винтом,   - 

угловая скорость гребного винта, C  - коэффициент, связывающий 

скорость вращения винта и создаваемую им тягу. 

 

Модель системы автоматического управления, построенная в 

среде Simulink показана на рисунке 12. 

 
Рисунок 12 Модель системы автоматического управления 
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2.1 Модель робота  
Модель робота реализована средствами SimMechanics – набора 

инструментов, доступного при использовании Simulink. Модель ро-

бота содержится в подсистеме Robot. На рисунке 13 показано содер-

жание этой подсистемы.  

 

 
Рисунок 13 Подсистема Robot, содержащая модель робота, построен-

ную с привлечением средств SimMechanics 

 

Входным параметром для подсистем Robot является суммарная 

сила, приложенная к роботу. выходными – положение и скорость ро-

бота. Указанная модель использует блоки SimMechanics Second Gen-

eration, которые можно найти в библиотеке Simulink, как это показа-

но на рисунке 14. 
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Рисунок 14 Расположение использованных блоков SimMechanics 

Second Generation в библиотеке Simulink 

 

Часть использованных блоков относится к набору Simscape, ча-

стью которого является SimMechanics. Расположение этих блоков в 

библиотеке приведено на рисунке 15. 

 

 
Рисунок 15 Расположение использованных блоков Simscape в биб-

лиотеке Simulink 

 

Блоки Solid, Prismatic Joint, и Mechanism Configuration требуют 

настройки. На рисунках 16 и 17 показаны использованные настройки 

блоков. Настройка блока Solid заключается в указании массы робота. 

Настройка блока Prismatic Joint заключается в определении его вхо-

дов и выходов (входом является сумма внешних сил, выходами по-
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ложение и скорость робота). Настройка блока Mechanism Configura-

tion заключается в указании величины и направления ускорения сво-

бодного падения. В данном случае нас интересует движение в плос-

кости, перпендикулярной линиям гравитационного поля, поэтому 

можем указать нулевую величину ускорения свободного падения. 

 

 
Рисунок 16 Настройки блока Solid 

 

  
Рисунок 17 Настройки блоков Prismatic Joint, и Mechanism Configura-

tion 
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Отметим, что сила сопротивления жидкости моделируется как 

пропоруиональная скорости робота, с помощью блока Gain. 

 

2.2 Разработка и настройка нечеткого регулятора 
 

Для создания нечеткого регулятора вопспользуемся 

расширением MATLAB - Fuzzy Logic Designer. 

Для вызова приложения Fuzzy Logic Designer используется ко-

манда fuzzyLogicDesigner: 
 

Листинг 1 Вызов приложения Fuzzy Logic Designer 

 
 

После выполнения команды fuzzyLogicDesigner появляется окно, 

показанное на рисунке 18. 

 

 

Рисунок 18 Окно приложения Fuzzy Logic Designer 

 

 

По умолчанию приложение генерирует регулятор с одним вхо-

дом input1 и одним выходом output1. Переименуем вход и выход в 

DistanceLeft, а выход в Speed. Результат показан на рисунке 19. 
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Рисунок 19 Окно приложения Fuzzy Logic Designer; вход и выход пе-

реименованы 

 

Дважды кликнув на вход откроем окно редактирования функ-

ций принадлежности. Отредактируем эти функции так, как показано 

на рисунке 20. 

 

   
Рисунок 20 Настройка функций принадлежности 

 

Обратим внимание, что для выхода были выбраны Гауссовы 

функции принадлежности, а для входа – треугольные. Менять тип 

функции можно используя выпадающий список Type. Гауссовым 
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функциям принадлежности соответствует тип gbellmf, а треугольным 

– trimf. Каждую функцию принадлежности следует переименовать в 

соответствии с еѐ физическим смыслом. 

Следующим шагом является запись набора нечетких правил. 

Используемый набор правил был приведен ранее. Результат записи 

набора правил показан на рисунке 21. 

 

 

Рисунок 21 Набор нечетких правил 

 

Работу нечеткого регулятора хорошо иллюстрирует поверх-

ность отклика. Приложение Fuzzy Logic Designer имеет встроенный 

инструмент построения таких поверхностей. Для вызова данного ин-

струмента следует кликнуть на пункт главного меню View->Surface, 

или нажать Ctrl+6. В рассматриваемом случае поверхность отклика 

представляет собой график, показывающий связь между входными и 

выходными величинами разработанного нечеткого регулятора. В 

случае, если бы регулятор имел более одного входа, поверхность от-

клика задавалась бы действительной функцией двух переменных, т.е. 

поверхностью в трехмерном пространстве, с чем и связано название 

«поверхность отклика». Внешний вид полученного графика показан 

на рисунке 22.  
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Рисунок 22 График, показывающий связь между входными и выход-

ными величинами разработанного нечеткого регулятора 

 

Приложение Fuzzy Logic Designer позволяет провести анализ 

влияния отдельных функций принадлежности на работу системы. 

Для этого используется Rule Viewer. Для того, чтобы вызвать окно 

Rule Viewer нужно кликнуть на пункт главного меню View->Rules, 

или нажать Ctrl+5. В открывшемся окне можно перемещать линию, 

моделирующую входное значение регулятора, задавая тем самым 

различные входные величины. Rule Viewer графически изображает 

разработанные для данного регулятора входные функции принад-

лежности. Те из них, в которые попадает данный входной сигнал, бу-

дут подсвечены. Для каждого входного сигнала показано как он 

влияет на работу выходных функция принадлежности, а также пока-

зан найденный центр масс выходных функций – выходное значение 

регулятора. Внешний вид окна Rule Viewer показан на рисунке 23. 
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Рисунок 23 Внешний вид окна Rule Viewer при имитации различных 

входных сигналов  

 

Для того, чтобы сохранить созданный нечеткий регулятор нуж-

но кликнуть на пункт главного меню File->Export->To File, или на-

жать Ctrl+S. Можно сохранить регулятор в переменную, которая бу-

дет доступна в приложениях MATLAB, для этого нужно кликнуть на 

пункт главного меню File->Workspace->To File, или нажать Ctrl+T. 

Данная переменная будет удалена после окончания работы 

MATLAB, или после принудительной очистки памяти (например ко-

мандой clear). 

Для того, чтобы загрузить ранее созданный нечеткий регулятор 

нужно кликнуть на пункт главного меню File->Import->From File, или 

нажать Ctrl+O. 

Для того, чтобы использовать созданный регулятор в среде Si-

mulink, требуется использовать блок Fuzzy Logic Controller. на ри-

сунке 24 показано расположение этого блока в библиотеке Simulink. 

 

Рисунок 24 Расположение блока Fuzzy Logic Controller в библиотеке 

Simulink 
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Блок Fuzzy Logic Controller требует указать имя файла из кото-

рого будет считан нечеткий регулятор, или имя переменной содер-

жащей этот регулятор. Здесь будем использовать второй способ. На 

рисунке 25 показаны настройки блока Fuzzy Logic Controller. 

 

 
Рисунок 25 Настройки блока Fuzzy Logic Controller 

 

Для того, чтобы создать переменную FLcontroller, которая будет 

использована блоком Fuzzy Logic Controller, выполним следующий 

скрипт (см. рисунок 26). Данный скрипт устанавливает значения всех 

использованных в данной работе переменных. 

 

 
Рисунок 26 Скрипт, задающий переменную FLcontroller 

 

Такой способ работы с блоком Fuzzy Logic Controller оправдан 

тем, что это позволяет динамически модифицировать нечеткий регу-

лятор используя Fuzzy Logic Designer, сохраняя результаты в виде 
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переменной, что быстрее чем сохранение в файл. Сохранить резуль-

таты работы в файл будет необходимо один раз в конце сессии рабо-

ты с Fuzzy Logic Designer. 

Для запуска скрипта требуется нажать на кнопку Run. 

Запустим моделирование созданной Simulink модели, отобразим 

результаты в виде графиков (см. рисунки 27 и 28). 

 

 
Рисунок 27 Временная зависимость положения робота 

 

 
Рисунок 28 Временная зависимость входного сигнала блока Fuzzy 

Logic Controller 
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Рисунок 29 Временная зависимость выходного сигнала блока Fuzzy 

Logic Controller 

 

Для того, чтобы блок Scope отображал графики темными тона-

ми на светлом фоне, можно использовать следующие настройки бло-

ка (см. рисунок 29): 

 

 
Рисунок 29 Настройки отображения графиков в блоке Scope 

 

В случае, если количество точек на графике. отображаемом 

блоком Scope превышает 5000 нужно модифицировать его парамет-

ры хранения данных, иначе будут построены лишь последние 5000 

точек. На рисунке 30 показаны соответствующие настройки блока 

Scope. 
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Рисунок 30 Настройки хранения информации в блоке Scope 

 

Численные значения параметров, использованных в данной ла-

бораторной работе, приведены в таблице 1. 

 

 

3. Задание на выполнение самостоятельной работы 

 

Задание на выполнение лабораторной работы следует выбирать 

из таблицы 3 в соответствии с номером студента в списке группы. 

 

Таблица 1 Задания на выполнение лабораторной работы 

№ Задание 

1 Настроить нечеткий регулятор таким образом, чтобы 

уменьшить колебательность системы. Использовать единич-

ное задающее воздействие. 

2 Настроить нечеткий регулятор таким образом, чтобы пони-

зить время переходного процесса. Использовать единичное 

задающее воздействие. 

3 Настроить нечеткий регулятор таким образом, чтобы пони-

зить перерегулирование. Использовать единичное задающее 

воздействие. 

4 Настроить нечеткий регулятор на отработку нарастающего 

задающего воздействия. 

5 Настроить нечеткий регулятор таким образом, чтобы 

уменьшить колебательность системы. Использовать задаю-

щее воздействие y = 20. 
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6 Настроить нечеткий регулятор таким образом, чтобы пони-

зить время переходного процесса. Использовать задающее 

воздействие y = 20. 

7 Настроить нечеткий регулятор таким образом, чтобы пони-

зить перерегулирование. Использовать задающее воздейст-

вие y = 20. 

8 Настроить нечеткий регулятор таким образом, чтобы устра-

нить колебательность системы. Использовать задающее воз-

действие y = 30. 

9 Настроить нечеткий регулятор таким образом, чтобы пони-

зить время переходного процесса. Использовать задающее 

воздействие y = 30. 

10 Настроить нечеткий регулятор таким образом, чтобы пони-

зить перерегулирование. Использовать задающее воздейст-

вие y = 30. 

 

 

4. Оформление отчета о выполнении работы 

 

Требования к отчету:  

 отчет содержит титульный лист, описание выполняемого 

задания, описание проделанной работы, анализ полученных 

результатов, выводы, список использованной литературы; 

 отчет выполняется на листах формата А4, 14 кегль, одинар-

ный межстрочный интервал; 

 список литературы оформляется согласно ГОСТ 7.1-2003. 
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Перечень информационных технологий, используемых при  

осуществлении образовательного процесса по дисциплине 
 

Visual Studio Professional 2015, договор IT000012385 

GNU Octave  https://www.gnu.org/software/octave/  Бесплатная, GNU 

General Public License 
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